Users Manual for the Surface Currents Data Base (SCDB) Management System (SCDBMS) Version 1.0
Technical Note 07-94
August 1994

Prepared for: Naval Oceanographic Office, Stennis Space Center, Mississippi
Contract Number: NAS 13-330 / Order No. 53

Approved for public release; distribution is unlimited.
Mississippi State University Center for Air Sea Technology
Building 1103, Stennis Space Center, MS 39529-6000
SOFTWARE USER'S MANUAL

FOR THE

SURFACE CURRENTS DATABASE MANAGEMENT SYSTEM (SCDBMS)

SCDBMS Version 1.0 (23 August 1994)

CONTRACT NO: NAS 13-330, Order No. 53

Prepared for:

NAVAL OCEANOGRAPHIC OFFICE
STENNIS SPACE CENTER, MS 39529

Prepared by:

Mississippi State University
Center for Air Sea Technology
Building 1103, Room 233
Stennis Space Center, MS 39529-6000
Acknowledgements

UNIX is a trademark of American Telephone and Telegraph (AT&T), Incorporated
SUN, SUNOS and SparcStation are trademarks of Sun Microsystems, Incorporated
Motif is a trademark of the Open Software Foundation
X-Windows is a trademark of the Massachusetts Institute of Technology
Empress is a trademark of Empress Software, Incorporated
UNIRAS ag/X Toolmaster is a trademark of Advanced Visual Systems, Incorporated

Contributors to the design and development of the SCDBMS application are:

Ms. Cheryl Cesario, Software Engineer/Project Manager
Mr. Ramesh Kirshnamagaru, Senior Software Engineer
Mr. Valentine Anantharaj, Research Assistant
Mr. Vishnu Mohan Das, Programmer

Contributors to the SCDBMS Software User’s Manual are:

Ms. Cheryl Cesario, Project Manager
Mr. Ramesh Krishnamagaru, Senior Software Engineer
Mr. Valentine Anantharaj, Research Assistant
Mr. Michael S. Foster, Graphics and Editing
# Table of Contents

<table>
<thead>
<tr>
<th>Section Description</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Sheet</td>
<td>i</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>ii</td>
</tr>
<tr>
<td>List of Figures</td>
<td>iii</td>
</tr>
<tr>
<td>Listing of Appendices</td>
<td>iv</td>
</tr>
<tr>
<td>1 SCOPE</td>
<td></td>
</tr>
<tr>
<td>1.1 Identification</td>
<td>1</td>
</tr>
<tr>
<td>1.2 Overview</td>
<td></td>
</tr>
<tr>
<td>1.2.1 Logical Data Overview</td>
<td>1</td>
</tr>
<tr>
<td>1.2.2 Functionality Overview</td>
<td>2</td>
</tr>
<tr>
<td>1.2.3 Administration Overview</td>
<td>2</td>
</tr>
<tr>
<td>1.2.4 Support Overview</td>
<td>2</td>
</tr>
<tr>
<td>1.3 Document Overview</td>
<td>2</td>
</tr>
<tr>
<td>1.3.1 References</td>
<td>3</td>
</tr>
<tr>
<td>1.3.2 Format and Content</td>
<td>3</td>
</tr>
<tr>
<td>1.3.3 Definitions and Conventions</td>
<td>3</td>
</tr>
<tr>
<td>2 REFERENCED DOCUMENTS</td>
<td>4</td>
</tr>
<tr>
<td>3 EXECUTION PROCEDURES</td>
<td></td>
</tr>
<tr>
<td>3.1 Initialization (Launching the Application)</td>
<td>5</td>
</tr>
<tr>
<td>3.2 Initialization Files</td>
<td>5</td>
</tr>
<tr>
<td>3.3 Description of Display Windows</td>
<td>5</td>
</tr>
<tr>
<td>3.3.1 Title Area</td>
<td>6</td>
</tr>
<tr>
<td>3.3.2 Data Selection Area</td>
<td>6</td>
</tr>
<tr>
<td>3.3.2.1 Data Selection Area: Classification (Listbox)</td>
<td>6</td>
</tr>
<tr>
<td>3.3.2.2 Data Selection Area: Source Code (Listbox)</td>
<td>7</td>
</tr>
<tr>
<td>3.3.2.3 Data Selection Area: Month (Listbox)</td>
<td>7</td>
</tr>
<tr>
<td>3.3.3 Selection Status Area</td>
<td>7</td>
</tr>
<tr>
<td>3.3.3.1 Selection Status Area: Default Values</td>
<td>7</td>
</tr>
<tr>
<td>3.3.3.2 Selection Status Area: Minimum and Maximum Toggles</td>
<td>7</td>
</tr>
<tr>
<td>3.3.3.3 Selection Status Area: Latitude and Longitude Values</td>
<td>7</td>
</tr>
<tr>
<td>3.3.3.4 Selection Status Area: Time Values</td>
<td>8</td>
</tr>
<tr>
<td>3.3.3.5 Selection Status Area: Classification, Source Code and Month Values</td>
<td>8</td>
</tr>
<tr>
<td>3.3.4 Menu Bar</td>
<td>8</td>
</tr>
<tr>
<td>3.3.4.1 Select (Menu Header)</td>
<td>8</td>
</tr>
<tr>
<td>3.3.4.1.1 Select: Region</td>
<td>8</td>
</tr>
<tr>
<td>3.3.4.1.2 Select: Time</td>
<td>9</td>
</tr>
<tr>
<td>3.3.4.1.3 Select Data</td>
<td>10</td>
</tr>
<tr>
<td>3.3.4.1.4 Select Exit</td>
<td>10</td>
</tr>
<tr>
<td>3.3.4.2 MDBA (alias SCDBA)</td>
<td>10</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>3.3.4.2.1 MDBA: Import (SCDBA Only)</td>
<td>10</td>
</tr>
<tr>
<td>3.3.4.2.2 MDBA: Export</td>
<td>11</td>
</tr>
<tr>
<td>3.3.4.2.3 MDBA: Update Table (SCDBA Only)</td>
<td>11</td>
</tr>
<tr>
<td>3.3.4.2.3.1 MDBA: Update Table: Update Source (SCDBA Only)</td>
<td>11</td>
</tr>
<tr>
<td>3.3.4.2.3.2 MDBA: Update Table: Update Class (SCDBA Only)</td>
<td>12</td>
</tr>
<tr>
<td>3.3.4.3 Products</td>
<td>13</td>
</tr>
<tr>
<td>3.3.4.3.1 Products: Inventory</td>
<td>13</td>
</tr>
<tr>
<td>3.3.4.3.2 Products: Plots</td>
<td>13</td>
</tr>
<tr>
<td>3.3.4.3.3 Products: Print Log</td>
<td>16</td>
</tr>
<tr>
<td>3.3.4.4 Util</td>
<td>17</td>
</tr>
<tr>
<td>3.3.4.4.1 Util: Read Defaults File</td>
<td>17</td>
</tr>
<tr>
<td>3.3.4.4.2 Util: Write Defaults File</td>
<td>18</td>
</tr>
<tr>
<td>3.3.4.5 Help</td>
<td>18</td>
</tr>
<tr>
<td>3.3.5 Remarks</td>
<td>18</td>
</tr>
<tr>
<td>3.4 Using the SCDB Management System</td>
<td></td>
</tr>
<tr>
<td>3.4.1 SCDBMS Features</td>
<td></td>
</tr>
<tr>
<td>3.4.1.1 Database Queries</td>
<td></td>
</tr>
<tr>
<td>3.4.1.1.1 Manual Initialization of a Database Query</td>
<td></td>
</tr>
<tr>
<td>3.4.1.1.2 Using Parameter Initialization Files</td>
<td></td>
</tr>
<tr>
<td>3.4.1.2 Importing Data (SCDBA Only)</td>
<td></td>
</tr>
<tr>
<td>3.4.1.3 Exporting Data</td>
<td></td>
</tr>
<tr>
<td>3.4.1.4 Updating Parameter Selection Tables (SCDBA Only)</td>
<td></td>
</tr>
<tr>
<td>3.4.1.5 Viewing the Data</td>
<td></td>
</tr>
<tr>
<td>3.5 Examples</td>
<td></td>
</tr>
<tr>
<td>3.5.1 Setting Up the Opening Display</td>
<td></td>
</tr>
<tr>
<td>3.5.2 Reading Default Information from a File</td>
<td></td>
</tr>
<tr>
<td>3.5.3 Writing Default Information to a File</td>
<td></td>
</tr>
<tr>
<td>3.5.4 Using File Resident Data</td>
<td></td>
</tr>
<tr>
<td>4 ERROR MESSAGES</td>
<td></td>
</tr>
<tr>
<td>5 NOTES</td>
<td></td>
</tr>
<tr>
<td>5.1 Glossary</td>
<td></td>
</tr>
<tr>
<td>5.2 Abbreviations (acronyms)</td>
<td></td>
</tr>
<tr>
<td>5.3 System Considerations</td>
<td></td>
</tr>
<tr>
<td>5.3.1 System/Software Requirements</td>
<td></td>
</tr>
<tr>
<td>5.3.2 Directory Map</td>
<td></td>
</tr>
<tr>
<td>5.3.3 Security</td>
<td></td>
</tr>
<tr>
<td>5.3.4 Installation Procedures</td>
<td></td>
</tr>
</tbody>
</table>
## LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Import and export file format for surface current observations</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Surface Currents Database Management System (SCDBMS) Opening Display Screen</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>REGION SELECTION Window</td>
<td>9</td>
</tr>
<tr>
<td>4</td>
<td>TIME SELECTION Window</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>MDBA Filename Entry Dialog Window for Importing Files</td>
<td>11</td>
</tr>
<tr>
<td>6</td>
<td>MDBA Filename Entry Dialog Window for Exporting Data to Files</td>
<td>11</td>
</tr>
<tr>
<td>7</td>
<td>MDBA Update Source Window</td>
<td>12</td>
</tr>
<tr>
<td>8</td>
<td>MDBA Update Classification Window</td>
<td>13</td>
</tr>
<tr>
<td>9</td>
<td>The Products &quot;Plots&quot; Window</td>
<td>14</td>
</tr>
<tr>
<td>10</td>
<td>Example Stability Plot</td>
<td>14</td>
</tr>
<tr>
<td>11</td>
<td>Example Maximum Current Plot</td>
<td>15</td>
</tr>
<tr>
<td>12</td>
<td>Example Average Report File Output</td>
<td>15</td>
</tr>
<tr>
<td>13</td>
<td>Example Summary Report File Output</td>
<td>16</td>
</tr>
<tr>
<td>14</td>
<td>The Products Print Log Window</td>
<td>17</td>
</tr>
<tr>
<td>15</td>
<td>Read Defaults File Window</td>
<td>17</td>
</tr>
<tr>
<td>16</td>
<td>Write Defaults File Window</td>
<td>18</td>
</tr>
</tbody>
</table>

## LIST OF APPENDICES

<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Glossary of Terms</td>
<td>A-1</td>
</tr>
<tr>
<td>B</td>
<td>List of Acronyms</td>
<td>B-1</td>
</tr>
<tr>
<td>C</td>
<td>User Default File</td>
<td>C-1</td>
</tr>
<tr>
<td>D</td>
<td>Commercial and Non-Developmental Software (NEONS, Empress, ag/X Toolmaster, X-Windows, OSF Motif)</td>
<td>D-1</td>
</tr>
<tr>
<td>E</td>
<td>SCDBMS Installation Procedures</td>
<td>E-1</td>
</tr>
</tbody>
</table>
1 SCOPE

1.1 Identification

Computer Software Configuration Item: Surface Current Database Management System (SCDBMS).

Version: 1.0.

Release Date: 23 August 1994.

Contract No: NAS 13-330, Order No. 53

Contractor: Mississippi State University
Center for Air Sea Technology
J. H. Corbin, Director
Building 1103, Room 233
Stennis Space Center, MS 39529-6000
Telephone: (601) 688-2561
Facsimile: (601) 688-7100

Project Manager: Ms. Cheryl Cesario, Mississippi State University
Center for Air Sea Technology, Stennis Space Center, Mississippi
39529-6000. (MSU Proposal No. 93-3-467)
Telephone: (601) 688-7141
Facsimile: (601) 688-7100

1.2 Overview

The SCDBMS provides access to the Surface Current Data Base (SCDB) which is maintained by the Naval Oceanographic Office (NAVOCEANO). The SCDBMS incorporates relational database technology in providing seamless access to surface current observational data. The SCDBMS is an interactive software application. A graphical user interface (GUI) supports user access to its functional capabilities.

1.2.1 Logical Data Overview

The SCDBMS operates exclusively on surface current observation data. Each observation is composed of a location (latitude and longitude), a date (month, year, day), a classification code, a source code, the current speed (in knots) and direction (in degrees from which the current is flowing). The order and arrangement of the data elements contained in a surface current observation file are illustrated in Figure 1. Header information is neither necessary nor included in surface current observations data files. The import/export data files are written in ASCII format (SCDB ADMIN). Within the database, surface current data is stored using the generic latitude/longitude/time (LLT) data structure of the Navy Environmental Operational Nowcast System (NEONS).
1.2.2 Functionality Overview

The SCDBMS supports user defined database queries and searches of the SCDB. The SCDBMS also allows surface current data to be imported from external files for ingestion into the SCDB. Conversely, surface current data resident in the database may be retrieved and written to external files. Finally, the SCDBMS provides a limited suite of database management and data visualization tools.

1.2.3 Administration Overview

Access to SCDBMS features is based upon a hierarchy of classification criteria. Presently, the SCDB exists as a single, unclassified database. Access to the SCDBMS is controlled by the SCDB Administrator (SCDBA). Questions regarding access to the SCDBMS should be addressed to the SCDBA.

**Surface Current Data File Format**

<table>
<thead>
<tr>
<th>Latitude</th>
<th>Longitude</th>
<th>Classification</th>
<th>Year</th>
<th>Current Speed</th>
<th>Current Direction</th>
<th>Month</th>
<th>Day</th>
<th>Source Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>140.85</td>
<td>-142.85</td>
<td>1100010</td>
<td>7</td>
<td>71</td>
<td>13</td>
<td>0.090</td>
<td>150</td>
<td>0</td>
</tr>
<tr>
<td>43.07</td>
<td>-144.66</td>
<td>1100100</td>
<td>7</td>
<td>71</td>
<td>13</td>
<td>0.130</td>
<td>145</td>
<td>2</td>
</tr>
<tr>
<td>41.33</td>
<td>-135.82</td>
<td>1100011</td>
<td>7</td>
<td>71</td>
<td>14</td>
<td>0.520</td>
<td>231</td>
<td>0</td>
</tr>
</tbody>
</table>

Figure 1. Import and export file format for surface current observations. Each line is a separate observation. There is no header in the file. The file is written in ASCII mode and the format has been named “SCDB ADMIN”.

1.2.4 Support Overview

This manual represents the core document supporting users of the SCDBMS. System specifications are described in the SCDBMS Design Document. In addition to this manual, refer to documentation for proprietary (commercial) software and non-developed (government provided) software (NDS) which are integrated into the SCDBMS. These integrated software items are described in Appendix D of this manual.

1.3 Document Overview

This is the final SCDBMS user’s manual.
1.3.1 References

Documents referenced within this manual are listed in Section 2. Where referenced in the text, the document name is followed by the appropriate subparagraph number of Section 2 where complete reference information may be found. Within Section 2, each reference is followed by a parenthetical listing of paragraph numbers within the manual where the reference is cited.

1.3.2 Format and Content

The format and content of this manual are in accordance with Data Item Description (DID) number DI-MCCR-80019A of the Department of Defense (DoD) Standard 2167A “Defense System Software Development” (2.1).

1.3.3 Definitions and Conventions

In order to simplify and standardize communication of procedural details to the user, this manual incorporates the following definitions and conventions:

Definitions:

button - When used in relation to the mouse device, a button is one of three pressure switches which may be pressed (clicked) to control some feature of the screen display. When used in relation to the monitor display, a button is a labeled area of the on-screen graphical design which resembles a switch which can be activated by pressure.

click - The act of pressing a button on the mouse. The term “click on”, or simply “click”, is frequently used to indicate that the user should maneuver the mouse cursor to a specified location on the screen (usually an area designed to resemble a button) and press (click) the appropriate button on the mouse.

cursor - A graphical symbol that identifies a position on a computer monitor screen. A cursor is sometimes controlled by moving a mouse device; otherwise, it is controlled from the keyboard, usually with the arrow keys.

display - Synonymous with the computer monitor screen; also, to demonstrate or to show.

drag - The act of pressing and holding a button on the mouse device and moving the mouse to control cursor movement across the monitor screen. The purpose of dragging the mouse device is to define an area on the screen or to move a graphical object to another location on the screen.

listbox - An outlined area of the display which contains two or more rows of textual information. Selection of text within a row is accomplished by placing the mouse cursor over the row and clicking an appropriate button on the mouse.

mouse - A hand controllable device used to interact with images displayed on the computer monitor screen. When a mouse is moved, a cursor on the screen display moves in the same direction as the mouse. One or more buttons may be present on a mouse for invoking an action on screen at the corresponding cursor position.
rubber band - The act of dragging the mouse to define an area on the screen. A mouse button is pressed and held while the mouse is maneuvered to position the on-screen cursor at a desired final position; then, the mouse button is released. The defined screen area is usually outlined as a rectangle with dashed lines indicating the boundary.

screen - The display surface of a computer video monitor where images appear in response to bombardment by electrons.

scrollbar - The graphical image of a narrow bar with arrows embedded at both ends and, sometimes, a movable (sliding) button between them. The scroll bar is used to position a portion of an image or text for viewing inside a bound area that is smaller than the total image or text. Scrolling is accomplished by placing the mouse cursor on one of the arrows and pressing the mouse button. Scrolling may also be accomplished by placing the mouse cursor over the sliding button and dragging the sliding button to a new position along the scrollbar.

textbox - an outlined area of the display which contains textual information. Text in a textbox may sometimes be edited; however, the usual purpose of a textbox is to provide information to the user. A textbox is not scrollable.

window - An outlined area of the screen whose contents are confined to the outlined boundary and controlled by user interaction (with buttons, menus, etc.). A window is usually a top level structure closely tied to the operating environment of the computer.

NOTE: Additional definitions are contained in Appendix A.

Keyboard Entry: Text printed in *italics* in this manual represents information which is to be entered via the keyboard as written (usually followed by pressing the enter or return key).

Mouse Button Convention: Most "click" or "select" operations with the mouse use the left button. Unless otherwise specified, instructions to "click" or "select" refer to the left mouse button. When a "click" or "select" operation using the middle or right mouse button is required, the specific mouse button will be indicated in the text; otherwise, the left mouse button may be assumed.

2 REFERENCED DOCUMENTS

This user's manual either 1) contains references to the following documents, or 2) summarizes information contained in them which is appropriate for further reading:


3 EXECUTION PROCEDURES

3.1 Initialization (Launching the Application)

The SCDBMS observes the standard procedure for executing an application in the X Windows environment. Within the X Windows environment, enter scdb -f filename or scdb at the system prompt. -f filename is optional; the -f flag indicates that the next parameter is the name of an initialization file (you may have as many default files as you desire). If only scdb is entered, the SCDBMS will look for the "scdb.defaults" file in the current directory. The SCDBMS main display will appear after interim window manager procedures are completed (e.g., If using "toms window manager" - "twmrc" a window skeleton appears on screen which must be maneuvered to the desired position on the monitor screen with the mouse. If using "motif window manager" - "mwmrc", the position of the main display is predefined and appears without any further action after the command line entry. Other window managers may involve different procedures before the main display appears.).

3.2 Initialization Files

Initialization files contain default settings for maximum and minimum values of the key search/query/retrieval parameters required by the SCDBMS. Instructions for creating initialization files are provided in Appendix C. Questions regarding implementation of initialization files should be directed to the SCDBA. If an initialization file cannot be found, (1) textbox displays within the "Selection Status" area of the main SCDBMS display will be blank (no initial values), (2) the message "Error Reading Defaults File" will be displayed in the "REMARK:" textbox at the bottom of the main SCDBMS display window, and (3) the SCDBMS will use global default values resident in the application.

3.3 Description of Display Windows

The screen displays of the SCDBMS are X-Windows clients. Window control adheres to standard X Windows procedures. As illustrated in Figure 2, the opening display is subdivided into five major areas: (1) title area; (2) "Data Selection" area; (3) "Selection Status" area; (4) pull-down menu bar; and (5) the "REMARKS" area. The functionality and purpose of each area of the display is described below and illustrated in Figure 2.
3.3.1 Title Area

The title area, which occupies (approximately) the top one-fifth of the display, has no purpose except to identify the application as the "NAVAL OCEANOGRAPHIC OFFICE SURFACE CURRENTS DATABASE MANAGEMENT SYSTEM".

3.3.2 Data Selection Area

The "Data Selection" area of the main display window occupies most of the left half of the display. It contains 3 smaller, labeled areas for changing three of the maximum and minimum parameter values displayed in the "Selection Status" area which occupies the right half of the display. Parameter ranges defined in the "Data Selection" area are effective during database searches, queries and retrievals. Each parameter within the "Data Selection" area must be accessed to modify the corresponding minimum or maximum parameter values displayed in the "Selection Status" area.

3.3.2.1 Data Selection Area: Classification (Listbox)

This scrollable listbox contains the classification codes for NAVOCEANO surface current observations. These codes may only be selected one at a time, by clicking on the line containing the desired code. Classification codes are multi-digit positive integers that control and restrict access to the data. Classification codes can only be changed by the SCDBA. Each line in the "Classification" listbox contains a unique code followed by textual information describing that code. When selected, a classification code is copied into the "Selection Status" area of the main display window as a maximum or minimum value adjacent to the label "Classification". Since all data in the SCDB is unclassified, the use of classification codes by the SCDBMS reflects subcategories of the generic "unclassified" category, e.g., public domain and military critical technology.

Figure 2. Surface Currents Database Management System (SCDBMS) Opening Display Screen.
3.3.2.2 Data Selection Area: Source Code (Listbox)

This listbox displays numerical codes and accompanying information about the sources of data contained in the SCDB. Source codes are positive integers. Only one source code can be selected at a time. Source codes are copied into the "Selection Status" area adjacent to the label "Source Code". If more than 5 source codes are defined, the "Source Code" listbox becomes a scrollable list. Source codes can only be changed by the SCDBA.

3.3.2.3 Data Selection Area: Month (Listbox)

The "Month" scrollable listbox displays the twelve months of the year. Months may be selected one at a time. The month selected from the "Month" listbox is copied into the "Selection Status" area adjacent to the label "Month".

3.3.3 Selection Status Area

The "Selection Status" area contains a matrix of textboxes which display minimum (first column) and maximum (second column) values for each labeled criteria (row). The two top rows ("Latitude" and "Longitude") are set by selecting "Region" from the "SELECT" pull-down menu (see subpara. 3.3.4.1.1). The third row ("Time") values are set by selecting "Time" from the "SELECT" pull-down menu (see subpara. 3.3.4.1.2). The remaining rows of minimum and maximum values are set from the "Data Selection" area, accessing each labeled criteria once to modify the minimum value (first column) and once to modify the maximum value (second column). "Selection Status" textboxes cannot be edited. Each textbox in the "Selection Status" area must contain a value; otherwise the SCDBMS will not perform a search of the SCDB.

3.3.3.1 Selection Status Area: Default Values

When launched, minimum and maximum parameter values displayed in "Selection Status" textboxes are obtained by reading an initialization file. Unless the initialization file name is included in the command line following the "-f" flag, the SCDBMS will look for the "scdb.defaults" file in the current directory. Initialization files can be modified by the user or SCDBA (see Appendix C for instructions on creating user initialization files). If an initialization file cannot be found, "Selection Status" area textboxes will not be initialized with entries at start up.

3.3.3.2 Selection Status Area: Minimum and Maximum Toggles

The two columns within the "Selection Status" area are supervised by two toggle buttons - "Minimum" above the left column, and "Maximum" above the right column. Each button may be alternately activated and deactivated by successive clicks. When activated, these buttons are red; when inactive, they are displayed in shades of the background color. When the "Minimum" toggle is active (red), all modifications performed in the "Data Selection" area affect the "Minimum" column. The "Maximum" toggle button evokes the same behavior in the "Maximum" column. If no toggle button is active, any selections from the "Data Selection" area will default to the "Minimum" column.

3.3.3.3 Selection Status Area: Latitude and Longitude Values

In the "Selection Status" area, a south latitude or a west longitude are given as negative values. North latitude and east longitude are displayed as positive values (plus sign understood).
Latitude and longitude values may be initialized from a user or default (scdb.defaults) initialization file, or, determined from the “REGION SELECTION” window available by clicking the “Region” option from the “SELECT” pull-down menu.

### 3.3.3.4 Selection Status Area: Time Values

The row labeled “Time” contains minimum and maximum date/time constraints to be applied to SCDB retrieval operations. Times may be initialized from a user or default (scdb.defaults) initialization file, or, determined from the “TIME SELECTION” window available by clicking the “Time” option from the “SELECT” pull-down menu.

### 3.3.3.5 Selection Status Area: Classification, Source Code and Month Values

The three bottom rows of the “Selection Status” parameter matrix are linked to their like-labeled counterparts in the “Data Selection” area of the display. To modify classification, source code or month values, click the appropriate minimum or maximum button atop each column; then, select the desired new parameter(s) from the like-labeled section of the “Data Selection” area.

### 3.3.4 Menu Bar

The pull-down menus are accessed by clicking the labeled menu header buttons in the menu bar. Subordinate menu items are then displayed as additional labeled buttons below the top-level (header) button. The user may select a menu-item by clicking. When a pull-down menu item is selected, a window will usually open to reveal pertinent options. When pull-down menus items are visible, they may be closed by clicking in a neutral area of the SCDBMS display window or by clicking another menu header button.

#### 3.3.4.1 Select (Menu Header)

The “SELECT” pull-down menu button is the leftmost button in the menu bar. “SELECT” offers options for defining regional boundaries (“Region”), time constraints (“Time”) and the data source (“Data”). The “SELECT” pull-down menu also offers the option to “Exit” from the SCDBMS and return to the system command line prompt.

#### 3.3.4.1.1 Select: Region

Clicking the “Region” button opens a “REGION SELECTION” window which permits definition of geographic region boundaries. The “REGION SELECTION” window is illustrated in Figure 3. Information defined using this window is copied into the “Latitude” and “Longitude” textboxes within the “Selection Status” portion of the main display. The “REGION SELECTION” window supports three methods of defining latitude/longitude boundaries:

1. **Predefined Region:** By clicking on a pre-defined region in the scrollable “REGION LIST” listbox. The pre-defined region will be displayed as a dashed rectangular border in the map displayed in the right portion of the “REGION SELECTION” window. **Predefined regions can only be modified, added, or deleted by the SCDBA.**

2. **Keyboard Entry:** By selecting “REGION COORDINATES” textboxes and entering (via the keyboard) latitude/longitude coordinates of the northwest and southeast corners of a geographic region. Note that latitude and longitude entries in “REGION COORDINATES” textboxes are given in N, E, S, W notation; whereas, in the “Selection Status” area of the main SCDBMS display,
south latitude and west longitude displays as negative values while north latitude and east longitude
displays as positive values (plus sign understood).

(3) Rubber Band: By dragging the mouse cursor from an initial position on the map display
to a final position. The defined region appears on the map display as a rectangular area bounded by
dashed lines. When the cursor lies within the map display boundary, its position is displayed as
latitude/longitude coordinates in the “LAT:” and “LON:” textboxes located below the map display.
Vertical and horizontal scrollbars allow positioning of the map display. The “Zoom” button located
below the map display opens a window which displays an enlarged view of a defined region when
clicked. The rubber band technique may be also be applied within the zoomed window to further
refine the desired geographic area (Note: “LAT:” and “LON” textboxes below the map display do
not reflect cursor coordinates within the “ZOOM” window.). If visible, the “Zoom” button will
enlarge geographic regions defined within the zoomed window. To close the zoom window, click
the right mouse button within the zoom window boundary. The coastline depicted on the map
display is composed of plotted points rather than connecting lines in an effort to optimize coastline
plotting speed. At sufficiently high zoom resolution, the coastline will become ill-defined.

The pull-down “File” menu header within the “REGION SELECTION” window contains options
to “RESET” the region coordinates to those values listed in the “Selection Status” area and to
“Exit” the “REGION SELECTION” window. When finished with the “REGION SELECTION”
window, click the “File: EXIT” pull-down menu item to close the window and update the
“Latitude” and “Longitude” textboxes within the “Selection Status” area of the main SCDBMS
display.

Figure 3. REGION SELECTION Window. There are three ways to identify regional boundaries:
(a) select a named area from the REGION LIST, (b) enter upper left and lower right coordinates
from the keyboard in the REGION COORDINATES display, (c) use the cursor to “rubberband”
the desired region within the geographic chart display.

3.3.4.1.2 Select: Time

When the “Time” menu-item button is clicked, a “TIME SELECTION” window opens for
defining minimum and maximum date and hour limits. Time limits defined in the “TIME
SELECTION” window are reflected in the “Time” criteria row within the “Selection Status” section
of the main display. The “TIME SELECTION” window is illustrated in Figure 4.
**Entering Time Information:** The "TIME SELECTION" window allows setting of "START" (minimum) and "END" (maximum) times for database search/query/retrieval operations. Clicking on the diamond-shaped "RESET" button places default time components in the active "START" or "END" row of textboxes. The active row of textboxes is selected by clicking on a diamond-shaped button adjacent to the "START" or "END" label. When active, the "START" and "END" buttons are displayed in red, and, the button and label area is outlined. Textboxes in the active row ("START" or "END") may be edited from the keyboard when selected. Time entries may also be changed using the up- and down-arrow switch buttons associated with "YEAR", "MONTH", "DAY", and "JULIAN" textboxes at the bottom of the window. These arrow switches are manipulated by clicking.

![Figure 4. TIME SELECTION Window.](image)

### 3.3.4.1.3 Select Data

The "Data" button allows the user to choose the source of input data. Two options are available via a pop-up dialog window - "Database" and "File". The default option is "Database", meaning data will be retrieved from the SCDB to support the session unless "File" is selected. If "File" is selected, a standard directory/file selection dialog window is displayed, allowing identification of the path and file name of a previously extracted (SCDB Admin-format) data file. When finished with the "Data" pop-up dialog, click the "Ok" button to close it.

### 3.3.4.1.4 Select Exit

Clicking the "Exit" menu-item closes the SCDBMS main display screen and returns the user to the system command line prompt.

### 3.3.4.2 MDBA (alias SCDBA)

The "MDBA" pull-down menu contains options to "Import" and "Export" data to/from the SCDB. It also contains an "Update Table" option. The "Import" and "Update Table" options are available only to the SCDBA user account.

#### 3.3.4.2.1 MDBA: Import (SCDBA Only)

Selecting the "Import" option from the "MDBA" pull-down menu has no effect unless you are the SCDBA. When the "Import" menu item is selected from the "MDBA" pull-down menu, a dialog window (Figure 5) appears for entering the filename (with pathname if the file is not located in the current directory). To be imported, the file must be in the "SCDB ADMIN" format (see Figure 1). After entering the filename from the keyboard, click the "OK" button to close the dialog.
window and import the surface currents data from the named file. If the file cannot be accessed, the
dialog window will close automatically and the message “Cannot Access File” will be sent to the
“REMARK:” textbox in the main SCDBMS display. If the data cannot be ingested into the SCDB,
the “REMARK:” textbox will contain the message “Import Aborted; Check Format”. Clicking the
“Exit” button closes the “Import File” dialog window without importing the named file.

Figure 5. MDBA Filename Entry Dialog Window for Importing Files.

3.3.4.2.2 MDBA: Export

When the “Export” menu item is selected from the “MDBA” pull-down menu, a dialog
window (Figure 6) appears for entering the filename for exported data. Data is exported in the
SCDB ADMIN format. After entering the filename from the keyboard (including the path if the file
is to be written to a directory other than the current directory), click the “OK” button to export
SCDB data to the named file. If the file is written, the message “Data Exported to File” is displayed
in the “REMARK:” textbox in the main SCDBMS display. If the file cannot be written, the
“Export” dialog window closes and the message “Export aborted” is sent to the “REMARK:”
textbox.

Figure 6. MDBA Filename Entry Dialog Window for Exporting Data to Files.

3.3.4.2.3 MDBA: Update Table (SCDBA Only)

Selecting options within the “Update Table” menu item from the “MDBA” pull-down menu
has no effect unless you are the SCDBA. When selected by the SCDBA, the “Update Table” menu
item displays two options: “Update Source” and “Update Class”. These options allow the SCDBA
to update information listed in the “Source Code” and “Classification” listboxes in the “Data
Selection” area of the main SCDBMS display.

3.3.4.2.3.1 MDBA: Update Table: Update Source (SCDBA Only)

When selected, the “update_source” menu item displays the “UPDATE SOURCE”
window. As illustrated in Figure 7, this window allows new source numbers and descriptions to
be added to the listing of data sources in the “Source Code” listbox of the “Data Selection” area.
Existing entries can be edited or deleted. The “Source Number” and “Source Description” text
entry boxes can be cleared. The “Source” scrollable listbox can be returned to its original state by
clicking the “Reset” button. You may close the “UPDATE SOURCE” window by clicking the “Exit” button.

a. To add a new entry to the “Source Code” textbox, (1) select the “Source Number” text entry box and enter the appropriate source number, (2) select the “Source Description” text entry box and enter the appropriate descriptive information and (3) click the “Add” button.

Figure 7. MDBA Update Source Window.

b. To edit an existing entry contained in the “Source Code” textbox, (1) select the source from the listing in the scrollable “Source” textbox, (2) make changes to the source code information displayed in the “Source Number” and “Source Description” text entry boxes and (3) click the “Update” button.

c. To delete an existing entry from the “Source Code” textbox, (1) select the source to be deleted from the “Source” window and (2) click the “Delete” button.

3.3.4.2.3.2 MDBA: Update Table: Update Class (SCDBA Only)

When selected, the “Update Class” menu item displays the “UPDATE CLASS” window. As illustrated in Figure 8, this window allows new classification number codes and descriptions to be added to the listing of classification codes displayed in the “Classification” listbox within the “Data Selection area. Existing entries may be edited or deleted. The “Class Number” and “Class Description” text entry boxes can be cleared and the “Classification” listbox can be returned to its original state by clicking the “Reset” button. You may close the “UPDATE CLASS” window by clicking the “Exit” button.

a. To add a new entry to the “Classification” textbox, (1) select the “Class Number” text entry box and enter the appropriate new classification number, (2) select the “Class Description” text entry box and enter the appropriate new descriptive information and (3) click the “Add” button.

b. To edit an existing entry contained in the “Classification” textbox, (1) select the classification information line from the “Classification” textbox, (2) make changes to the classification information displayed in the “Class Number” and “Class Description” text entry boxes and (3) click the “Update” button.

c. To delete an existing entry from the “Classification” textbox, (1) select the classification information line from the “Classification” textbox and (2) click the “Delete” button.
3.3.4.3 Products

The "PRODUCTS" pull-down menu offers three options. The "Inventory" menu item is a placeholder for future upgrade and performs no action in the current implementation of the SCDBMS. The "Plots" menu item supports preparation of plots and reports. The "Print Log" menu item allows printing of log reports of historical actions affecting the SCDB content.

3.3.4.3.1 Products: Inventory

This is a "hook" for future upgrade. Selecting "Inventory" produces no response in the current implementation of the SCDBMS. The "Inventory" menu item hints at potential use as the access point to routines that provide information about SCDB content.

3.3.4.3.2 Products: Plots

When the "Plots" menu item is clicked, the plot options dialog window, Figure 9, is displayed. The user may choose a coastline resolution from those stored in the SCDB by clicking the "Coastlines" button and selecting the desired resolution from among those listed. Output may be sent to the "Screen", a "Printer", or to a "Print File" by selecting the appropriate option within the "Print Options" section of the dialog window. Available "Plots" are listed for user selection and slide bars are provided for setting the relative "Arrow Length" (vectors), "Text Expansion" and "Text Height". Only one plotting option may be selected at a time. Two types of "Reports" are available, "Average File" and "Report Summary". Either of these reports may be configured to output the "Number of Observations" or the "Number of Observations + Percentage". Only one report option may be selected at a time. All options are selectable by clicking appropriately labeled buttons. In addition, file names may be entered from the keyboard into the textboxes, or, the default entries may be accepted as presented in the dialog window. After configuring the dialog window to produce the desired plot or report, selecting the "OK" button creates and displays/prints the product. To view the arrow color legend used in ocean current plots, select the "Show Legend" button. To produce a printout of the legend, select the "Print Legend" button. When finished, the dialog window may be closed by clicking the "Exit" button.
Available SCDB Data Plots: Six graphical plots are available for selection ("Stability", "Maximum Current", "Mean Current", "Number of Observations", "Average Scalar" and "No Plots"). An example "Stability" plot is presented in Figure 10. Plots of the "Number of Observations" and "Average Scalar" values are similar to the "Stability" plot. Figure 11 illustrates a "Maximum Current" plot which is similar to the "Mean Current" plot.
Available Reports: Average Reports and Summary Reports are produced by selection of the "Average Report" and Summary Report" buttons, respectively. Figure 12 illustrates the results of an "Average Report" request. An example "Summary Report" is given by Figure 13.

**Figure 11. Example Maximum Current Plot**

**Figure 12. Example Average Report File Output**
### Figure 13. Example Summary Report File Output

#### 3.3.4.3.3 Products: Print Log

The “Print Log” output selection window, Figure 14, appears when the “Print Log” menu item is selected from the “Products” pull-down menu. This window presents a list of functions that may be performed on the SCDB. Any one of the functions may be selected by clicking the mouse. The name of an authorized user (or the wild-card “*”) and a date range may be entered in textboxes to the right of the “Functions” listbox. The logged transaction information for the selected function and the named user during the indicated date range may be printed to a file, a printer or to the display screen by selecting the appropriate output option button. A “Message” textbox is also present for user feedback. Select the “Ok” button to produce the log printout. Configuration of the “Print Log” dialog may be reverted to its initial default state by clicking the “Reset” button. The “Print Log” dialog may be closed by clicking the “Exit” button.
3.3.4.4 Util

The "UTIL" pull-down menu currently provides options for users to read or write SCDBMS default files. Default files contain maximum and minimum values of parameters appearing in the "Selection Status" portion of the main SCDBMS display.

3.3.4.4.1 Util: Read Defaults File

When clicked, the "Read Defaults File" menu item opens the "Load Defaults File" window, Figure 15, for selection/entry of a filename. To be accepted, the selected file must conform to the initialization (default) format described in Appendix C. When "Load" is clicked, the file named in the "Selection" listbox is read and its contents replace existing values in the "Selection Status" area. If successful, the "REMARK" textbox will contain the message "New Defaults File Loaded". If unsuccessful, the "REMARK" textbox will respond with "Error reading Defaults: Clearing Defaults". To close the "Read Defaults File" window, click the "Exit" button.
3.3.4.4.2 Util: Write Defaults File

When clicked, the “Write Defaults File” menu item opens a “Write Defaults File” window, Figure 16, for entry of a filename. When “Ok” is clicked, the named file is created and the current values contained in “Selection Status” textboxes are written to the file in the initialization (default) file format described in Appendix C. This feature permits users to save initialization parameter settings for subsequent use. If successful, the “REMARK” textbox will contain the message “Written To File”. If unsuccessful, the “REMARK” textbox will inform “Cannot Open File to write Defaults”.

![Figure 16. Write Defaults File Window.](image)

3.3.4.5 Help

The “Help” pulldown menu offers on-line assistant to the user. Help is available on SCDBMS software procedures and techniques from the menu items that appear when the “Help” menu header is selected. Help on each subject is provided in a series of pop-up help screen windows that appear in response to menu item selection. When additional help is available, it may be accessed by clicking the “Help” button located in the lower right corner of a help screen. To close a help screen, click the “Ok” button, located in its lower left corner.

3.3.5 Remarks

The buff-colored “Remark” textbox is located in the lower left corner of the display window. The “Remark” textbox provides notification of errors, event status and communicates instructions for follow-on interaction by the user.

3.4 Using the SCDB Management System

The previous subsection (3.3) of this manual describes the screen displays, windows, and the functional mechanics required to operate the SCDBMS. This subsection discusses operational use of the SCDBMS. The SCDB is a moderate size database. To optimize performance, the database has been physically partitioned into 10 public (unclassified) geographical regions and 4 restricted geographical regions. Each regional domain contains the surface current data for all years within that domain. Logically, the SCDBMS projects a seamless, integrated view of the SCDB that hides the underlying physical structure.

3.4.1 SCDBMS Features

The SCDBMS is the user “front end” for the NAVOCEANO SCDB. It enables access to the SCDB by authorized users and supports the database management and control functions vested in the SCDBA. The SCDBMS supports database queries, data ingestion and extraction, data visualization, user help and error reporting. For the SCDBA, the SCDBMS supports maintenance
of query criteria and historical records. Button labels for SCDBA-only features are inactive when other users execute the SCDBMS.

### 3.4.1.1 Database Queries

Most SCDBMS features involve a database query as the initial process. Consequently, the opening SCDBMS display has been designed for interactive construction of database queries. SCDB queries are based on parameters contained in SCDB headers. The minimum and maximum values of 6 parameters must be initialized before the SCDBMS executes a database query; otherwise, an error message will be sent to the “Remarks” textbox by SCDBMS functions that require a database query. The 6 query parameters are displayed in the “Selection Status” section of the main SCDBMS display. Except for Latitude and Longitude, minimum and maximum query parameters may be set to the same value. Query parameters may be initialized manually or by reading a default file. A database query does not occur until the user selects an SCDBMS function that requires it.

#### 3.4.1.1.1 Manual Initialization of a Database Query

Latitude and Longitude limits are defined in the “REGION SELECTION” window which is accessed through the “Region” button of the “SELECT” pulldown menu. Time limits are defined in the “TIME SELECTION” window which is accessed through the “Time” button of the “SELECT” pulldown menu. The remaining 3 parameters are initialized by the “Data Selection” portion of the main display, as a minimum or maximum value, in accordance with the status of the “Minimum” and “Maximum” toggle buttons in the “Selection Status” portion of the main display. Manual parameter initialization may occur in any order. Existing values may be modified at will within the constraints of the “Data Selection” display.

#### 3.4.1.1.2 Using Parameter Initialization Files

When the SCDBMS is launched by entering `SCDB` at the UNIX command line, the application automatically looks for the “SCDB.defaults” file in the current directory. There are two additional options for setting query parameters using parameter initialization files:

a. From the command line, enter `SCDB -f filename`. The flag “-f” tells the SCDBMS that the next argument (“filename”) is the name of a file to use instead of “SCDB.defaults”. The “-f” flag is the only flag currently implemented by the SCDBMS.

b. By entering the name of a parameter initialization file into the dialog box which appears when the “Read Defaults File” button is selected from the “UTIL” pulldown menu. This option allows the user to implement an alternate parameter initialization file from within the application, thereby obviating the need to exit from the SCDBMS to do so.

Parameter initialization files may be created by saving existing parameter values. This is accomplished by clicking the “Write Defaults File” button under the “UTIL” pull-down menu, entering the filename and clicking “Ok” to create the file.

### 3.4.1.2 Importing Data (SCDBA Only)

The SCDB data import function is reserved for SCDBA use only. A database query is not necessary for data import. It is important to note that repetitive import of the same data file produces duplicate data in the SCDB. The existence of duplicate profiles in the SCDB may require
database cleanup by the SCDBA using direct SQL commands to the Empress rdbms engine. The only criteria available for differentiating between duplicate SCDB profiles may be the unique loading date assigned to each profile when imported into the database. To be imported, data must be in the SCDB ADMIN format; otherwise an error will be reported. Importing data has no effect on parameter settings within the main SCDBMS display. Imported data is automatically sorted by region before ingestion into the database.

3.4.1.3 Exporting Data

Within classification constraints, all users may extract surface current data to a file. The data to be exported is determined by the parameter range settings in the “Selection Status” section of the main display. The database query occurs when the “Ok” button is clicked after entering the output file name. All SCDB data that lies within the minimum and maximum ranges of the key parameters displayed in the “Selection Status” display will be written to the named file. Subsequent exports to the same file will overwrite any previous output; i.e., exported data is not appended to the file.

3.4.1.4 Updating Parameter Selection Tables (SCDBA Only)

The SCDBA may add, delete or modify classification codes, instrument types and source codes through the “Update Table” option of the “SCDBA” pulldown menu. Numerical codes and descriptions are not preset by the SCDBMS. Each parameter (Classification Code or Source Code) is treated as a separate entity in the “Update Table” submenu; however, procedures are much the same for each. A deleted parameter value is immediately removed from the parameter listbox. When added, a new parameter value is initially appended to the listing; however, in subsequent accesses to the parameter update window, the new parameter value appears properly inserted within the listing. The numerical identification codes and the informative text associated with them may be edited as separate entities, even though each listbox line contains both the code and the text.

3.4.1.5 Viewing the Data

The “PRODUCTS” pulldown menu supports visual display of SCDB data as map plots and reports. The data represented in the plots and reports are those present for the region, time, source code and classification code established within the “Selection Status” portion of the main display. The products may be viewed on screen or sent to a printer. Plots may written to a postscript file and reports may be written to an ASCII (text) file for archiving and later use.

3.5 Examples

This example demonstrates how to set up the opening display, read data from a file, write data to a file, and view the data.

3.5.1 Setting Up the Opening Display

Getting Started:

1. At the system prompt, enter “scdb”. The SCDBMS opening display screen will appear (Figure 1). All required parameters are provided to the opening display by the defaults file; however, you may make changes as described in this example.
Setting Region and Time:

2. Click the “Select” pull-down menu and select “Region”. The Region Selection window (Figure 2) will appear. Use either (1) the rubberband technique, (2) selection from the list of predefined regions, or (3) enter new region latitude/longitude coordinates from the keyboard. Close the window when finished by clicking the “File” menu, then the “Exit” menu item. Your modifications will be reflected in the “Selection Status” section of the opening display screen.

3. Click the “Select” pull-down menu and select “Time”. The Time Selection window (Figure 3) will appear. Click the “Start” button to change the beginning (start) date and time (minimum date and time). Click the “End” button to change the ending date and time (maximum date and time). When modifications are complete, click the “Exit” button. Your modifications will be reflected in the “Selection Status” portion of the opening display screen.

Setting Classification Codes, Months, and Source Code:

5. Click the “Minimum” or “Maximum” button located within the “Selection Status” portion of the opening display screen.

6. Select the desired classification code listed in the “Classification Code” textbox. If the desired code cannot be seen, use the scrollbar to view the remaining choices. The selected classification code will be reflected in the “Selection Status” portion of the opening display screen.

7. Months may be selected using the time selection procedure described in step 3, above. If step 3 was skipped, the minimum and maximum months may be chosen by selection from the “Months” textbox. If the desired month cannot be seen, use the scrollbar to view the remaining choices. The selected month will be reflected in the “Selection Status” portion of the opening display screen.

8. Select the desired source code from those listed in the “Source Code” textbox. If the desired source code cannot be seen, use the scrollbar to view the remaining choices. The selected source code will be reflected in the “Selection Status” portion of the opening display screen.

The opening SCDBMS display window is now configured.

3.5.2 Reading Default Information from a File

Perform the following steps to read data from a file:

1. Click the “Util” pull-down menu.

2. Select the “Read Defaults File” option from the pull-down menu.

3. Enter the path and file name to be read (e.g., /u/a/scdba/scdb/src/scdb.def).

4. Click the “Load” button and “Exit” button (in that order) or continue with these steps.

5. As an alternative to steps 1 through 4, you may select a directory and file from those listed in the scrollable textboxes; then, click the “Load” button followed by the “Exit” button.
3.5.3 Writing Default Information to a File

Perform the following steps to write data to a file:

1. Click the “Util” pull-down menu.
2. Select the “Write Defaults File” option from the pull-down menu.
3. Enter the path and file name to be written.
4. Click the “Ok” button to write the file.
5. Click the “Exit” button to close the dialog window.

3.5.4 Using File Resident Data

Data in SCDB Admin format may be retrieved from files instead of the SCDB. This is accomplished by selecting the “Data” menu item from the “Select” pull-down menu. A data selection dialog will be displayed. This dialog offers choices (buttons) for selecting “Database” (the default) or “File”. If SCDB retrieval is overridden by selection of the “File” option, a dialog will appear for entry of a path and file name. Any data file in SCDB Admin format may be read into the application memory; however, unless observations contained in the file conform to the configuration of the “Selection Status” board of the main display, they will not be present in product plots and reports.

4 ERROR MESSAGES

SCDBMS error messages are displayed in the “Remarks” textbox within the SCDBMS opening display window. Errors are reported when a selected dataset cannot be found within the SCDB or when an attempt is made to perform an illegal procedural action.

5 NOTES

5.1 Glossary

See the glossary contained in Appendix A for definitions of key terms used in this document. Also, see definitions given in Section 1.3.3.

5.2 Abbreviations (acronyms)

See the listing of acronyms in Appendix B for definitions of all acronyms.

5.3 System Considerations

The SCDBMS is intended for installation in and execution by Sun Microcomputers, Incorporated computing platforms. Installation is site specific and may be tailored to the environment. Appendix E provides information specific to installation of the SCDBMS within the
NAVOCEANO computing environment. The SCDBMS may be executed from an X-terminal; however, some graphical screens within the SCDBMS are memory intensive and will cause termination of the software if available memory is exceeded.

5.3.1 System/Software Requirements

The SCDBMS is an integrated software system that requires the presence of both specific commercial off-the-shelf software and government-provided software. While the details of integrated software item requirements are provided in Appendix D, the following general comments apply:

1. The SCDBMS was designed for execution under control of the UNIX operating system on Sun Microsystems hardware.

2. The SCDBMS requires the presence of the X-Windows client-server environment.

3. The Open Software Foundation’s (OSF) Motif Toolkit (library) must be present and available in the execution environment.

4. A runtime version of UNIRAS ag/X Toolmaster software must be installed on the system and available in the execution environment to support SCDBMS graphical display options.

5. The Empress relational database engine must be installed on the system and available for execution as the vehicle for accessing data contained in the SCDB.

6. The Naval Environmental Operational Nowcast System (NEONS) must be installed as the functional database model and library of database access tools.

7. Of interest to programmers, the software code for this version of the SCDBMS was compiled using C and Fortran compilers supplied by Sun Microsystems, Incorporated.

8. The SCDBMS is an interactive application. It supports all standard X-Windows mouse and keyboard functions. See Section 2 for references that explain X-Window procedures and terminology in greater detail.

5.3.2 Directory Map

SCDBMS software executables have been designed to execute via the following directory paths for integrated developmental and non-developmental software components:

SCDBMS: /u/a/scdba/scdb/src
SCDB: /u/a/scdba/db/db62
NEONS: /u/a/scdba/isdb_ltltn
Empress: /usr/local/empress/v6.2
UNIRAS ag/X Toolmaster: /usr/local/uniras/6v4a/base
X-Windows (X11R5): /usr/local/X11R5
OSF Motif: /usr/lib
These paths must be defined in the individual user’s login and/or shell scripts for execution upon logging into the system.

5.3.3 Security

The SCDBMS neither supports nor restricts the overall classification of the computing environment; however, classification codes are contained in the header information of each profile. The SCDBA controls access to SCDB data by authorizing classification code access to each user.

5.3.4 Installation Procedures

Appendix E describes procedures for installing the SCDBMS as an executable application within the NAVOCEANO computing environment.
Appendix A
Glossary of Terms

bathymetric  Of or pertaining to the depth of the ocean.

ingestion  The procedure whereby data is translated and transferred from an exterior format and placed within the SCDB for access under control of the SCDBMS.

Julian  The day of the year according to the Julian calendar which begins on January 1. A Julian date does not include a year as part of its simple format.

metadata  Information about a dataset, either descriptive or definitive as to quantity, quality, quantity or format.

profile  A sequential listing of parameters keyed to a reference structure. A bathymetric profile contains sequential depth/parameter groups.

zoom  The graphical scaling process whereby a screen display item is expanded or decreased in size.
Appendix B

List of Acronyms

CAST - Center for Air Sea Technology
CDRL - Contract Data Requirements List
DBA - Database Administrator
DiD - Data Item Description
DoD - Department of Defense
E - east
GUI - graphical user interface
Lat - latitude
Lon - longitude
max - maximum
min - minimum
MSU - Mississippi State University
mwmrc - “Motif window manager”, an X-Windows window manager
N - north
NAVOCEANO - Naval Oceanographic Office
NEONS - Naval Environmental Operational Nowcast System
OSF - Open Software Foundation
S - south
SCDB - Surface Currents Data Base
SCDBA - Surface Currents DBA
SCDBMS - SCDB Management System
twmrc - “Tom’s window manager”, an X-Windows window manager
W - west
Appendix C

User Default File

Default values for parameters appearing within the "Selection Status" textboxes of the SCDBMS main display may be maintained in a user-created default file. The user may specify the file containing default values by including the "-f" flag, followed by the filename, when launching the SCDBMS (example: scdb -f myfile.def). If the default file is not indicated on the command line, the SCDBMS will look for the file "scdb.def" in the current directory. If the "scdb.def" file cannot be located, parameter boxes within the "Selection Status" portion of the main display will be blank at start up. The format for a default file is as follows:

<table>
<thead>
<tr>
<th>Category</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Latitude</td>
<td>10.0</td>
</tr>
<tr>
<td>Max Latitude</td>
<td>25.0</td>
</tr>
<tr>
<td>Min Longitude</td>
<td>-100.0</td>
</tr>
<tr>
<td>Max Longitude</td>
<td>-70.0</td>
</tr>
<tr>
<td>Min Date</td>
<td>01/01/1900</td>
</tr>
<tr>
<td>Max Date</td>
<td>08/10/1993</td>
</tr>
<tr>
<td>Min Hour</td>
<td>0.0</td>
</tr>
<tr>
<td>Max Hour</td>
<td>23.0</td>
</tr>
<tr>
<td>Min Classification</td>
<td>1100010</td>
</tr>
<tr>
<td>Max Classification</td>
<td>1100010</td>
</tr>
<tr>
<td>Min Month</td>
<td>1</td>
</tr>
<tr>
<td>Max Month</td>
<td>12</td>
</tr>
<tr>
<td>Min Source</td>
<td>0</td>
</tr>
<tr>
<td>Max Source</td>
<td>15</td>
</tr>
</tbody>
</table>

The values contained in a default file are ordered in a left-to-right, top-to-bottom sequence according to their appearance within the "Selection Status" portion of the main display. The format is free form except that labels and numerical values must be separated by at least one space and each labeled line must end in a carriage return. For each labeled category, there is a single numerical entries, either a minimum and maximum value, on each line.

The numerical precision and default date formats contained in default file are not necessarily the same as formats displayed in the scrollable listboxes within the "Selection Status" or "Data Selection" portions of the SCDBMS main display screen. Note that the "Hour" entries in the "SCDB.def" file is in floating point format, which differs from the representation of the hour within the "Time" textbox in the SCDBMS main display. Also, the "Date" entries use different formats in the "scdb.def" file and the "Time" textbox within the "Selection Status" board of the SCDBMS main display.
Appendix D

Commercial and Non-Developmental Software (NEONS, Empress, UNIRAS, X-Windows, OSF Motif)

The SCDBMS has been developed to operate within a Sun Microsystems SparcStation model 10 computer hardware environment. The operating system is SUNOS version 4.1.3, including the resident SUN C compiler which was used to write the SCDBMS software code. Some minor elements of NEONS have been written in FORTRAN 77 (Sun FORTRAN 77 version 1.4). Graphics support is provided by UNIRAS ag/X Toolmaster version 6v4a. The RDBMS engine is Empress version 6.2. The windowing environment consists of X-Windows version X11R5 and the OSF Motif widget set version 1.3.
MSDBPERMS = WR, WR, WR
MSDBAPERIVS = scdba scdba user grant;
               scdba scdba alter
MSDBPRIVS =     scdba scdba all grant;
               scdba public user

Refer to the Empress “Database Administrator’s Guide” for assistance in customizing your database to meet your security needs.

Set the environment variable NEONS_DB within the .cshrc file to point to this directory.

    change   setenv NEONS_DB ?/neons_db
to        setenv NEONS_DB /u/a/scdba/db/db62

Source the modified .cshrc file to update the SCDBMS environment.

Run the import_db script to install the SCDBMS database tables.

* Create a directory to hold the NEONS software. Move the isdb.tar file to that directory. Extract the NEONS software tree from the isdb.tar file.

For example, suppose you wish to create a NEONS software directory within the existing directory path /scdbms. Execute the following commands:

        mkdir /scdbms/isdb_lltn
        mv isdb.tar /scdbms/isdb_lltn/isdb.tar
        change (cd) to the /scdbms/isdb_lltn directory
        tar xvf isdb.tar

Set the environment variable NEONS_SW within the .cshrc to point to this directory.

    change   setenv NEONS_SW ?/isdb
to        setenv NEONS_SW /u/a/scdba/isdb_lltn
           add $NEONS_SW/bin to the path
           set path = ($path $NEONS_SW/bin)

* Source the modified .cshrc file to update the scdba environment.
Run the Install script to make and install the NEONS libraries, shells and executables.

    source ~/scdba/.cshrc
    Install

* Run test examples under $NEONS_SW/src/*_ex to check connectivity between the SCDBMS database and the NEONS library software routines. (optional)
Appendix E

SCDBMS Installation Procedures

Instructions for:
1) Setting up the user .cshrc file.
2) Installing the SCDBMS Database files.
3) Installing the NEONS software tree.
5) Installing the SCDBMS user application resource files.
6) Installing the SCDBMS user application software.

Files provided:

cshrc - An example user .cshrc file.
db.tar - Tar file of the SCDBMS database files.
isdb.tar - Tar file of the NEONS software.
import_db - The import script that installs the SCDBMS database tables.
Install - The Install script that makes and installs the NEONS software libraries, shells and executables.
app-defaults.tar - Tar file of the SCDBMS user application resource files.
scdbms.tar - Tar file of the SCDBMS user application software.

SETUP ENVIRONMENT:

* Set up a login account as 'scdba'.
* Login as the scdba and execute umask 022.
* Identify the directory path for Empress version 6.x (installed).
* Identify the directory path for UNIRAS ag/X Toolmaster (installed).
* Modified or overwrite the .cshrc with the .cshrc provided on tape.
* Set the MSPATH environment variable within the .cshrc file to point to the location of Empress.

For example, suppose Empress was installed in /usr/empress:
change setenv MSPATH ?/empress/v6.2
to setenv MSPATH /usr/empress/v6.2

add $MSPATH/bin to path
set path = ($path $MSPATH/bin)

* Create a database directory which will contain the SCDBMS database. Use empmkdb to create the SCDBMS database. Refer to the Empress “Database Administrator’s Guide” for syntax.

Edit the tabzero file under the database directory, set the database permissions and privileges as required by your security environment.

For example, suppose your security environment is unclassified and wide open to the world. Setting the MSDBPERMS, MSDBDBAPRIVS and MSDBPRIVS Empress environment variables to the following will make your database public to the world:
* Create an ‘app-defaults’ directory. Move the app-defaults.tar file to that directory. Extract the SCDBMS application resource files from the app-defaults.tar file.

For example, suppose you wish to create an app-defaults directory under the scdba home directory: Execute the following commands:

```
mkdir ~scdba/app-defaults
mv app-defaults.tar ~scdba/app-defaults
cd (cd) to the ~scdba/app-defaults directory
tar xvf app-defaults.tar
```

Then, set the environment variable XAPPLRESDIR within the .cshrc to point to this directory.

```
setenv XAPPLRESDIR ~/app-defaults
to setenv XAPPLRESDIR ~scdba/app-defaults
```

* Create a SCDBMS application directory. Move the scdbms.tar file to that directory. Extract the SCDBMS application software tree from the scdbms.tar file.

For example, suppose you wish to create a SCDBMS application directory under /appl:

```
mkdir /appl/scdb
mv scdbms.tar /appl/scdb/scdbms.tar
cd (cd) to the /appl/scdb directory
tar xvf scdbms.tar
```

Then, make an executable of the SCDBMS application.

```
mv (cd) to the /appl/scdb/src directory and execute the command make.
```

Then, update the scdba .cshrc file to include the path to the SCDBMS executable.

```
add /appl/scdb/src to the path
set path = ($path /appl/scdbms/src)
```

* Source the modified .cshrc file to update the scdba environment.

```
source ~scdba/.cshrc
```

SCDBMS INSTALLATION AND ENVIRONMENT SETUP SHOULD NOW BE COMPLETED - If all went well!
Distribution List

1. Commanding Officer, Code N3211
   Naval Oceanographic Office
   Stennis Space Center, MS 39529
   (10 copies)

2. Technical Director
   Code OOT
   COMNAVMETOCOM
   Stennis Space Center, MS 39529

3. Oceanographer of the Navy
   U.S. Naval Observatory
   34th and Massachusetts Avenue
   Washington, DC 20392

4. Space and Naval Warfare
   Systems Command
   Code PMW175-3B
   2451 Crystal Drive
   Arlington, VA 22245-5200

5. Defense Technical Information Center
   Building 5, Cameron Station
   Alexandria, VA 22304-6145
   (2 copies)

6. Director, Sponsored Programs Administration
   Mississippi State University
   P.O. Box 6156
   Mississippi State, MS 39762
**Title and Subtitle:**

USERS MANUAL FOR THE SURFACE CURRENTS DATA BASES (SCDB) MANAGEMENT SYSTEM (SCDBMS) VERSION 1.0

**Authors:**

RAMESH KRISNAMAGARU  
M.S. FOSTER  
CHERYL CESARIO  
VALENTINE ANANTHARAJ

**Performing Organization:**

MISSISSIPPI STATE UNIVERSITY  
CENTER FOR AIR SEA TECHNOLOGY  
BUILDING 1103, ROOM 233  
STENNIS SPACE CENTER, MS 39529

**Sponsoring/Monitoring Agency:**

NAVAL OCEANOGRAPHIC OFFICE (CODE N3211)  
STENNIS SPACE CENTER, MS 39529

**Supplementary Notes:**

Research performed via Mississippi Research Consortium under NASA procurement Office Contract NAS13-330, Delivery Order #53.

**Abstract:**

The Surface Currents Database Management System (SCDBMS) provides access to the Surface Currents Database (SCDB) maintained by NAVOCEANO. This manual provides the user manual for the SCDBMS.

**Subject Terms:**

(U) User Manual  
(U) SCDBMS  
(U) SCDB  
(U) CAST  
(U) GUI  
(U) NAVOCEANO  
(U) NEONS

**Distribution/Availability Statement:**

Approved for public release; distribution is unlimited.

**Security Classification:**

UNCLASSIFIED

**Number of Pages:**

38

**Price Code:**

Approved for public release; distribution is unlimited.